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Takeout restaurants in the area

Best takeout restaurants in the bay area.

This place on Highway 175 is not far from Northern Bay, on the central coast of Maine, and is only open during the summer. Owners Larry and Freda Reynolds prepare hot food using mostly local ingredients, including lobsters and freshly caught fish. Crab rolls are the main dish, and fresh Bayview peekytoe is best enjoyed with a pinch of pepper on
the toasted sandwich. The Reynolds don’t have seating at home, but along the bay, customers often use a small group of picnic tables. Here’s the situation: you have a restaurant where guests can sit and eat. This is great, however, you see an opportunity to make more money: provide a take-out service to your customers. Providing a take-out menu is
a great opportunity to generate more income without worrying about the capacity of the restaurant and hiring additional waiters. A takeaway menu will attract customers who love your food but don’t have time to sit and eat, families who want to buy your food and enjoy it at home, and customers who want to buy your food for picnics, parties and
other events. Plan the foods you want to offer in your takeout menu. Selecting a simple menu will make order processing easy for you and make choosing a takeaway meal easy for your guests. Divide your take-away offers into categories, if you choose to do so. For example, you might have a category for appetizers, which might include garlic bread,
fries and mozzarella sticks. Then, move on to appetizers, side dishes and desserts. Determine prices for each menu item. Make sure your price is consistent. You might want to rate items in full dollar amounts or ending in 50 cents, or price items ending in nine cents. For example, a tuna sandwich can be valued at $4.00, and fries can be $1.50. Or, a
tuna sandwich can cost $3.99 and fries $1.49. Open Microsoft Word (or other word processing software) and start a new document. Save the document before you start entering any information. Periodically save the menu while creating it. Create a border for your menu. To do this in Word 2007, click the “Page Layout” tab and select “Page
Boundaries”. A simple border is better so people can focus on menu choices, although a border with images of ice cream cones may be appropriate for a take-away ice cream shop. If you prefer to make your menu more elegant, you can purchase pre-printed stationery and print your menu on the already decorated paper. Place a menu title at the top
of the menu using Word art. Select the “Insert” tab and select “WordArt”.Follow the instructions until you create a header that matches your attitude and theme Headers such as “Takeout Menu” or “Casey’s Restaurant Takeout Menu” are simple and easy to understand options. Add your restaurant logo to the menu. The “Insert” tab displays the
option to add an image or add clip art. Choose the option to add an image and add the restaurant logo. In bold, type the category header for the first of your menu. Magnify the font to at least fourteen font-size. Center the direction, if you like. Press Enter twice. Type the name of the first menu item. Press the tab several times to move the cursor to
the right of the page and enter the price of the item. Do the same for all other menu items in this category. Enter the header and menu items for the remaining categories. If the menu continues on a second page, make sure the second page starts with a new category. Do not start a menu section on one page and continue on the second, as restaurant
guests may not notice that the menu options continue on the second page. If the menu is two pages, make sure the menu is set to be printed on the front and back of the same page. Select “Print Preview” and make sure the menu fits the number of pages you want. Make any necessary changes to the menu font and save the finished product. Tips Be
creative with fonts, font sizes, and colors. Customize your restaurant’s menu to fit the style and personality you want the menu to portray. Make sure your menu is simple enough to understand easily. [llustration by Alex Castro / The Verge The pandemic has made take-away ordering a little less of a guilty pleasure, both because it is safer and because
it helps support local businesses. Google is now looking to make the process faster, too, by having Google Assistant fill in contact information and payment details automatically on Android phones after finding a restaurant through Google Search. To use the new feature, you need to search for the restaurant you want to order from in the Google app,
then select the “Order online” button on the restaurant information sheet. After selecting foods, you can tag in Google Assistant to complete your order using contact and payment information stored by Google Pay and Chrome Autofill. Assistant then confirms that you are ready to pay and the order has been placed. There are also some big limitations
to keep in mind: Google tells The Verge that Assistant will only be able to help with pickup orders for now, with deliveries coming at some point in the future. It also works only with restaurants Google has collaborated with for online ordering, and can only be started from the Google app on an Android phone. Google plans to add more restaurants in
the U.S. by the end of the year. Google claims Duplex is what powers this new takeaway trick, which might seem unusual given the origins of the technology. Duplex was initially introduced as a way to automate bookings and phone appointments, and was later implemented Automatic completion of forms for online car rental and movie ticket
purchase. As Google says Duplex has expanded, the item has become less central, but the basic theme is still that it’ll handle some work automatically for you. All these new duplex features have less immediate wow-factor than the original phone demo, but it could be cheaper: parsing and filling out online forms is a too common online activity,
especially when it comes to a restaurant you could only order from once. Having Assistant do busy work makes sense a and is less disturbing and confusing than a robotic phone call. Google Assistant a€oefind my phonea€TM notification will also work with iPhone as long as notifications are enabled. Image: Google Google Google also has a couple of
other new Wizard features that come in the short term: Smart home automated routines that can be set to activate at sunrise or sunset, and there’s a more useful feature “find my phone” for Apple devices, too. You've been able to ask a Google Home device to find iPhone and iPad for some time, but the feature didn’t work if the missing device was set
to silence or doesn’t have an internet connection. Now, if you opt to receive “critical alerts and notifications” from the Google Home app, Assistant can play a missing Apple device even if it has Non Disturb turned on. Ann Summa Thursdays here are particularly popular, when almost a dozen varieties of haute burgers are available. Try the cabbage
salad and brussel sprouts or the caramelized beets with the wild arugola flowers. Getty Images Located on Mount Telluride, at the exact elevation for which it is called, the restaurant rarely presents dishes from the rocky mountain, from the moose carpaccio... Read More With floor-to-ceiling windows overlooking the Telluride Valley and surrounding
peaks, Allred’s is a 12,000-foot restaurateur... Read more Housed in a former Old West saloon with a striped tent in front, Honga is bigger than it looks from the outside, with a sushi counter... Along the Old West-inspired Main Street in downtown Durango, Ken and Sue Fusco have merged two menus from previously owned locations to form this
larger... Read more This Mediterranean-American café and bakery opened in the Four Corners region in 2000. Local pastry chef Barbara Helmer and her business partner,... Read more For an intimate dinner, book a table at La Marmotte, a 125-year-old former glacier. Read more The Metate Room Restaurant at Far View Lodge, with its windows
overlooking all Four Corner states, serves Native American dishes such as... Growers can appreciate the Steam Engine Lager and Lizard Head Red served here, but the whole family can slip into pizzas, burgers and other goodies. Diners in this sushi kaiten or restaurant “sushi revolving” selects from an endless sushi parade on the belts of the
conveyor. Known for its steamed Chinese pork sandwiches, noodle bowls, and “hairy crabs” (a delicacy in the season during the fall), 50 Ban is No-frills, street food. to learn more and 'fun to sip a noon meal on a table grill in this new staple mall specialized in yakitori without skewers. try the tsukune, juicy, shiso. a Parisian sidewalk bar in one of the
most tonist of tokyo tokyoAnniversaire is a popular pit stop for buyers who need to power or relax after... Read More The scene: In the Akasaka district of Tokyo behind an unmarked door, whose only “sign” is engraved on the door handle, it is one of the world’s... Caffeine freaks that get deep about cream and acidity will love this place in funky
Shimokitazawa. Order Tanaka's signature drink, Dirty: espresso, cold... Located in the attic of the Chanel building in Ginza, this two-star Michelin restaurant is a collaboration between the French fashion house and... Yakitori — essentially the Japanese version of a kebab grilled chicken — is omnipresent in Tokyo, found everywhere from street stalls
to... Read More The room has a whole wall of coloured minigolf containers behind its beautiful circular bar. Try to order their junmai and daiginjo with... Read more Translated literally as "pig gang", this new tonkatsu temple occupies a characteristic wooden house in a quiet residential enclave near large, bright... Read more Combine traditional
elements of Japanese design, such as shoji screens and tatami mats, with dramatic contemporary art and lighting, Daidaiya... Located in a zen garden in Atago, Daigo is a restaurant shojin ryori (vegetarian restaurant) in the Buddhist tradition, housed in a temple building that has been moved... An elegant and elegant izakaya (living place) on the fifth
floor of a Marunouchi skyscraper, Daigomi presents a luxurious stuffta-yaki... One of the two sushi restaurants within the Tsukiji Fish Market, Daiwa is a traditional sushi counter with space for a dozen... Dazzle takes its name from Swarovski Crystal star lamps, LED, which seem to float over the cavernous dining room of this... Located on the seventh
floor of the Four Seasons Hotel in Marunouchi, Ekki stands out for its casual design (contemporaneous black lacquer furniture,... To learn more Sip coffee in the presence of the sapients in this store of hybrid zoological caffee: one of the latest animal coffees to appear in Japan. It's literally... The modern restaurant with red and black walls has the
coolest sushi in Tokyo. Located on the third floor of an office tower Ginza, Ginza Harutaka is a place known especially for sushi lovers, especially for Tokyo chefs. The intimate space... To learn more A welcome lunch break when you buy in Ginza, this restaurant serves kaiseki, multicourse meals of small traditional dishes. The emphasis is on... To learn
more He said he was the inspiration for the Japanese restaurant scene at Quentin Tarintino's Kill Bill Voume 1, Gonpachi is a warehouse-size, multi-level... The famous British chef Gordon Ramsay, starred in Tokyo, occupies oneon the 28th floor of the tower that houses the Conrad Hotel, offering... Read More Located inside the extravagance of multi-
attraction indoor call call the sparkling kitschy stadium is part flip-like pachinko sitting room,... Bauhaus meets Bushido at Ogata’s Higashi-yama restaurant, where everything from impeccable seafood to furnishings is... Read more A modern, bright space with seating on a wooden bench or on tables overlooking Tokyo (with an impressive corner of
Tokyo Tower), this... Isetan is one of the most popular department stores in Tokyo and its depchicka basement, or “food hall” (in the tradition of European shops as... Read More A highly ritualized and multi-course meal of “small bites”, kaiseki has evolved over the centuries as an off-shoot of Buddhist tea... Situated on the edge of the National
Cemetary of Aoyama, Kaotan Ramen has a particularly shady and simple interior: a wooden table and benches long and... Tsukemono (Japanese marinated vegetable) It is the specialty of this branch of the Kyoto Kintame restaurant. Located on a small side street in the... Read More The speciality of the house is a refined version of oden (Japanese hot
grass). Sit at the counter, select your oden ingredients from a large brass plate, and sip a... Read More It’s worth the nine-story ride in a claustrophobic and battered elevator: the open doors to Kondo, a Zen-calm dining room full of tans and blondes... Konpeki No Umi, which means “The Sea of Azure” & brings with it over 1,500 varieties of seafood
throughout the year. Experience the various kaiseki style... Read More Breathtaking views of the Tokyo skyline are the backdrop for Japanese cuisine in Kozue, located on the 40th floor of Park Hyatt Hotel. Wood... Read more Kurkku Kitchen is part of Tokyo’s green scene. Located in a modern, two-storey glass and wood building designed by the
architect with a... Paul Bocuse’s first restaurant outside of France, the legend of Lyonnais, occupies the beautiful glass and steel lobby of the National Art Center. He sits at the top of three... Les CrA©ations de Narisawa The brilliant forty-four-year-old chef Yoshihiro Narisawa combines French finesse and Spanish avant-garde with kaiseki aesthetics
and a passion for... Read more Some of the best French restaurants in the world can be found in Tokyo, and our favorite among them is the elegant Les Saisons at the Imperial Hotel. Read More Slip into a succulent tonkatsu of Kurobuta-pork (cutter) in a shaggy crunchy panko crust. Read more For soba noodles lovers, texture is paramount, and the
Matsugen noodle shop is reputed to have perfected it. Located on the third floor of a Ginza office tower,... Exclusive kaiseki restaurant (Japanese haute cuisine) with invitation only: but well-connected hotel concierges can... Read more Well-taken Ginza shopper and ladies lunch converge at the lounge on the 3rd floor of the Ginza 2 Building of also
known as "the Cheese... Classic Edo Sushi by Mitsugi-San, a a ateacher who encourages guests to eat the superb (and omakase courses at reasonable prices) at any time. Read More On one road in Tsukishima (an artificial island of the city), there are about 50 restaurants serving monja, a kind of pancake (some say... Read More Chef Kimio Nonaga
was awarded as the winner of the Iron Chef 2002 competition and served dishes for the imperial family, but... Read More Chef Seji Yamamoto’s Nihonryori Ryugin awards are impressive: three Michelin stars and the status of one of the world’s top 50 restaurants as... Read More Considered one of the most beautiful unagi (freshwater eel) homes in
Japan, Nodaiwa, a Michelin star, is located in an independent forest of three... Read More A renovated house in the rock and roll neighborhood of Shimokitazawa is now an organic coffeehouse serving rustic vegetable food. Wooden coffee tables... Read More A former merchantas home (decorated with Nihon-ga paintings, marble floors and antiques
preserved in glass windows) is home to the... Read More The restaurant is obscured behind a spectacular facade of steel and tempered glass. Regulars love this place not only for the tomakase... Read More Legendary French chef Pierre Gagnaire is known for his delicate dishes, designed to be eaten in progression to experience the nuances of every
taste... Read More The devotion of the sophisticated wealthy made the owner Kazuhiko Kinoshita a star and kept the 32 seats booked well in advance. Read More This minimalist jewel by Ginza has received a Michelin star for its divine kushiage (fried skewers). While the wine list is excellent, the happo sake... Read More Iron Chef Rokusaburo
Michiba’s restaurant is known for its excellent and innovative kaiseki with seasonal ingredients (Think: a broth... Read More Around the vast labyrinth of refrigerated stalls of the centrally located Tsukiji Fish Market, you will find simple dining... Read More Just two years after opening, Chef Carme Ruscellada’s first self-taught restaurant in the village
of San Pol de Mer in the north of Barcelona has earned a... Read More The line of wage earners descending the stairs of this ramen shelter is long, but give us courage: it moves fast, like these guys slurp like there.... Read More Soba is an ingredient in many Japanese dishes, from soups to soba moors, but it’s rare to find them handmade. In Sasuga,
diners can... Read More In 1834, a samurai established his reputation with his fruit and vegetable shop, introducing the then isolated Japan to imported products. More than 150... Read More Known as “French cuisine a la Tokyo”, Sens et Saveurs is the Tokyo outpost of identical twins Jacques and Laurent Pourcel, whose... Read More High-level
restaurant, housed in a brewery 19th century sake, serving traditional kaiseki with homemade tofu: fried, smooth, orIn the... Read More The name of the restaurant, Shunju, means spring and autumn. Dishes include items such as pike eel and summer vegetables in tempura, or homemade tofu made with... Read More Approximately translated,
tsugihagi means something similar to “patchwork” in English, and this is the apporach that this contemporary izakaya assumes throughout... Read More Thirty-seven floors of the Hotel Mandrin Oriental, the Michelin-starred Signature serves fine French cuisine in a rarefied atmosphere with... Read More Part of the avant-garde art gallery, part of the
dance club, part of the bar, Super Deluxe occupies an open basement space with concrete floors and high ceilings,... Read more In this sushi restaurant, Chef Masuda serves only the seasonal one and takes a closer look at the market that day. He trained with Jiro Ono for nine years, but... Read More Hidden inside a garage in Roppongi’s Ark Hills is
this world-famous sushi restaurant with eight seats. Inside, you will find an elegant wooden sushi bar... Read More The chef is the mentor of Masa Takayama, whose $450 omakase sushi has thrilled Manhattan sushi since the opening of his Masa restaurant in 2004. Read More Bowls of vegan steamed noodles, piled up with crispy vegetables and tasty
seasonings, are served at this hectic ramen restaurant inside Tokyo Station. Dinner... Read More Try the sashimi of the day and the seasonal nizakana (boiled fish in sake and soy) with rice, pickles and miso soup. Read more Shojin ryori (vegetarian cuisine of Buddhist monks) is served inside this temple on Mount. Takaoas Yakuoin. Walk-in meals are
available at lunchtime. Read More Tempura Mikawa, an intimate tempura house (only 22 seats) in the elegant Roppongi Hills, sits behind an unmarked wooden sliding door... Read More Tsukiji Market, the world’s largest fish market, is home to excellent sushi and tempura restaurants that open as early as 5:30 a.m. and close... Read More Tenko is
known for two things: its location inside an old wooden geisha house on a hidden side road in Kagurasaka and for its... Read More An imposing glass door decorated with modern gold carvings marks the entrance to this Michelin-starred teppanyaki (iron grill) in... Read More Teppei specializes in esoteric shochu liquors and 10 kinds of ume-shu
(plum). The hangout also serves Okinawan spam sushi & perversely... Read More Eight of Tokyo’s most famous ramen restaurants are gathered in one place at Tokyo Station. Here, ramen fans can choose from a myriad of flavors and... Read More Located on a side street between the trendy Harajuku and Aoyama districts, this small and cheerful
yakitori restaurant offers... Read more “Toriyoshi is a Japanese chain of yakitori. This position will in the central district of Minato, near the metro station Omotesando. Don't let some prejudice... Read More One of the last vestiges of anteguerra architecture inthe building that houses the flagship restaurant Tsunahachi tempura (Now there are dozens
of... Read More Come here for cool and beautifully structured noodles. The ginjo style sake called Koku-Ryu has the scent of pears and the sweet freshness... Read More Open, airy and contemporary (full-height glazing, exposed bricks, wooden floors and ulferated benches), Union Square brings the success of... Read More Renowned architect Kengo
Kuma created the impressive steel and glass screen and Super Potato design stars created the modern minimalist design... Read More After serving as executive chef at some of Tokyo’s top hotels, Yuki Wakiya opened this eponymous Chinese restaurant in 2001. Located in a quiet area... Read More Behind a green courtyard-like driveway, Yabu Soba
has an Old Tokyo flavor, with its dark wooden beams, paper lanterns and seating at the counter or... Read More 1zakaya (Japanese tapas bar) in the heart of Tokyo’s shitamachi district (Old Town) is a third-generation bar, old-fashioned... Read More Specializing in fish caught a few hours before being served, Yanmo is tucked away in a basement in the
fashionable shopping district of Aoyama and offers... Read More Japan’s love story with ramen paste is celebrated at the Shin-Yokohama Ramen Museum, an interactive exhibition space that includes a theme... Read More Traditional ryokan (host) on a quiet side street in Kyoto, Yoshikawa Inn offers classic Japanese hospitality in a century-old
building... Read more
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